Amarra

COMPUTER MUSIC PLAYERS

Amarra
Version 2.2
User Manual

Sonic Studio
# Amarra Table Of Contents

About This Manual 3

1.0.0 Thank you! 4

2.0.0 Minimum System Requirements: 4

3.0.0 Installing Amarra Software: 5
   3.1 Uninstalling Amarra Software 7

4.0.0 Authorization Of Your Amarra Product :: 8
   Authorizing Amarra After Evaluation Period Expires :: 10
   Information About The Amarra Authorization Process :: 10

5.0.0 Launching and Using Amarra 11
   5.1.0 Amarra Application Menus :: 12
   5.1.1 The File Menu: 12
   5.1.2 The Play Menu: 14
   5.1.3 The Playlist Menu: 14
   5.1.4 The Desk Menu: 14
   5.1.5 The Windows Menu: 15
   5.1.5 The Help Menu: 15
   5.2.0 The Amarra Background Manager: 16

6.0.0 Using Amarra and iTunes 18
   6.1.0 Using the Amarra Interface Module: 19
   6.2.0 Amarra EQ 20
   6.3.0 Amarra Preferences 23
   6.4.0 Using Amarra with Remote Control 24
   6.4.1 Remote Control Volume 24
   6.4.2 Using Amarra with Infrared Remote Control 24
   6.4.3 Using Amarra with Remote Control And Amarra Playlists 24
   6.5.0 Using your Airport Express 25
   6.6.0 Amarra Playlist Mode 26

7.0.0 Registering Your Amarra Software 29

8.0.0 Troubleshooting Guide 30
   Basic Macintosh Setup Tips 30
   Issue: Amarra Authorization Answers. 30
   Issue: Amarra operates in demo mode. 32
   Issue: How to set up a remote volume 32
   Issue: Audio Clicking or Ticking Sound. 33
   Issue: Songs do not change or sound correctly. 35
   Issue: Amarra does not play audio. 35
   Issue: Amarra does not play audio. 35
   Issue: Sample Rate Does Not Change With Soundfile. 35

9.0.0 Support 36
About This Manual
This manual, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the terms of such license. The information in this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Sonic Studio, LLC. Sonic Studio, LLC assumes no responsibility or liability for any errors or inaccuracies that may appear in this book.
Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Sonic Studio, LLC.

Notice of Liability
The author and publisher have made every effort to ensure the accuracy of the information herein. However, the information contained in this document is provided without warranty, either express or implied. Neither the authors, Sonic Studio, LLC, nor its dealers or distributors will be held liable for any damages to be caused either directly or indirectly by the instructions contained in this book, or by the software or hardware products described herein.

SONIC STUDIO, LLC MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. SONIC STUDIO, LLC DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SONIC STUDIO, LLC SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SONIC STUDIO SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.
IN NO EVENT WILL SONIC STUDIO, LLC, ITS DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SONIC STUDIO SOFTWARE EVEN IF SONIC STUDIO HAS BEEN ADVISED OF THE POSSIBILITy OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Notice of Rights
©2007-2.21 Sonic Studio, LLC — All rights reserved. No part of this document may be reproduced, stored in a retrieval system or transmitted in any form or by any means, without the prior written permission of the publisher:
Sonic Studio, Amarra, Amarra MINI, Amarra Junior, SSE, NoNOISE native, Sonic EQ, Model 302, Model 303, Model Four, Model 305 and the Sonic Studio and Amarra logos are trademarks of Sonic Studio, LLC. All other company or product names are either trademarks or registered trademarks of their respective owners.
1.0.0 Thank you!

Thank you for purchasing the Amarra Computer Music Player. You are about to enjoy the Ultrafidelity™ sound of Amarra. Designed to work with your Apple™ Macintosh Computer and with iTunes, Amarra provides a seamless integration for high resolution music playback.

The Amarra Team
Sonic Studio, LLC
330 Sir Frances Drake Blvd, Suite A  San Anselmo, CA USA  94960-2552
phone: 1-415-480-4601, 1-415-460-12.2
support@sonicstudio.com
www.amarraaudio.com

This document details the installation of Amarra and its associated software.

The Amarra 2.2 installer will install the following items on to your Macintosh Computer:

- Amarra Computer Music Player
- Amarra Documentation
- Amarra iTunes Plugin
- FLAC Component

2.0.0 Minimum System Requirements:

Computer:
- Any Intel–based Mac (Preferred)
- PPC (G5) Mac (NOTE: New licensing method not recognized. Use 2.1.1) (NOTE: WAV and AIFF files only. Compressed audio formats are not supported)
- RAM: 3 GB memory, 4 or more preferred (8 GB recommended for Memory Playback)
- For best results a high performance USB/FireWire audio interface

Software:
- Mac OS X 10.5, 10.6 and above recommended
  Compressed audio formats are not supported using OS X 10.4
- Amarra
- iTunes

Supported Audio Hardware Interfaces:
- Most Core Audio Interface will work with Amarra. This includes USB, FireWire, and optical connections on the Macintosh. Please visit the Hardware section of www.amarraaudio.com for more information.

Peripheral FireWire Adaptors supported:
- OHCI compliant PCCard, PCI card, ExpressCard or PCIe card

We recommend a fresh install of the operating system on a clean disc. This can prevent problems later on. We also highly recommend that your computer be used exclusively for music playback. Email, web browsers, screen sharing and other applications can all affect performance.
3.0.0 Installing Amarra Software:

To install Amarra, insert the install disk in your computer or locate the download of Amarra, then click on the Amarra_Installer icon. Follow the on screen instructions to install your software.

Welcome screen for Amarra Installer:

Select Continue.

Software License Agreement:
Select Continue.

Agree to the Software License Agreement
Please Read Carefully. Select Continue.

Select Agree to agree to the End-User Software License Agreement

Install Amarra:

Click Install.
(You will be prompted for your Mac password and the software will be installed.)
Success!

Select the Close button to quit the Amarra installer.

• Amarra Computer Music Player is installed into the Applications folder. 
  It is installed here: ~/Applications/Amarra

• The Amarra iTunes Plugin facilitates the interaction between Amarra and iTunes. 
  It is installed here: ~/Library/iTunes/iTunes Plug-ins/

• The iLok Extensions are required to use the iLok USB Security key. 
  The iLok extension is installed on your boot volume.

• Amarra FLAC installs QuickTime components used for native FLAC playback. 
  They are installed here: ~/Library/Components/

3.1 Uninstalling Amarra Software

To remove Amarra and uninstall the software please run the “uninstall amarra command” in the Amarra Application Extra’s Folder. This script may prompt you for your password and will remove Amarra and all installed components.
4.0.0 Authorization Of Your Amarra Product ::

Amarra is licensed for use via a simple Internet Authorization process. Please follow the steps below to Authorize your Amarra software. Also see Section 8 of this document for answers to questions regarding our authorization process.

Your Amarra Product is licensed for use via a simple Internet Authorization process. Please follow the steps below to Authorize your Amarra Product.

1) When you launch your Amarra Product the first time, you will be presented with the Authorization dialog box, Figure 1, below.

![Figure 1: Authorization dialog box.](image)

- **Evaluate button:** Allows an Amarra product to run in Evaluation Mode for a specific time. Your email address is required.
- **Activate button:** Securely sends your Activation Code, email address and unique password to authorize your Amarra Product.
- **Deactivate button:** Deactivates your Amarra product on the current computer and allow you to Activate Amarra on another computer.
- **Send Password button:** Sends the password you define to the email you provided.
- **Buy button:** Takes you to an online store to purchase Amarra.
- **OK button:** Cancels and closes the Authorization window.

2) Enter information into the provided fields..

   A) Copy and Paste your Activation code into the Activation Code area.
   B) Add your email address and create your own unique password in the appropriate fields. (Figure 2)
   C) Click on the Activate button to activate your Amarra product.

**IMPORTANT NOTE:**

If you purchase Amarra after April 15, 2011, your new Activation Code is delivered to you via email.
If you purchased Amarra before April 15, 2011, use your Amarra product Serial Number as your Activation Code.
Success! Your Amarra Software has been authorized.

**NOTE:** Note: When you reactivate a new release of Amarra, or move Amarra to another computer you will be asked for a new password. The window below will appear; type in a new password and click ‘OK’.

Be sure to store your password in a safe place for future reference.

Enter a new password to reactivate your copy of Amarra.
Authorizing Amarra After Evaluation Period Expires ::

After the Evaluation period has expired, it’s easy to receive an Activation Code that enables you to continue to enjoy the ultrafidelity sound of Amarra forever. Simply select the Buy button and you will be directed to an online store to purchase an Amarra product of your choice.

Your Activation Code will be sent to you via email. Once you receive your Activation Code, follow the steps outlined above to authorize your copy of an Amarra product.

Information About The Amarra Authorization Process ::

Activation is a set of simple and quick steps taken after your purchase of Amarra. It entitles you to use Amarra on your computer. If you’ve purchased products online or installed many of the Adobe products you have already used a similar activation system. When your application is authorized it contacts a central server across the internet to ‘activate’ your software and tie it to the provided activation code (which is generally provided by email).

This anti-piracy system helps protect your investment in Amarra and enables us to continue its development at a competitive price. The license protection and monitoring system is managed by software_DNA from softWORKZ Innovation Inc. This system does not collect any details about you or your computer during license activation and re-activation.

Unlike other activation systems, the software_DNA system for Amarra does not tie your license permanently to your computer hardware. Instead, your license is tied to your activation code and password that you define. As a result, you will have no problem re-activating your software after reformatting your hard drive, after upgrading hardware components in your computer; or when you move your software to a new computer. However, activation and re-activation does require an Internet connection. This Internet connection can be on a different computer from where your application is installed.
## 5.0.0 Launching and Using Amarra

Open the Applications folder on your Mac, locate the Amarra folder. This folder contains the Amarra application as well as documentation and an Extras folder.

Click on the arrow to the left to open the folder:

![Amarra folder and the Amarra application.](image)

**NOTE:** Launch Amarra first, not iTunes. Double clicking on the Amarra Junior icon launches Amarra and iTunes.

**HINT:** Drag and drop the Amarra application icon to your dock for easy launch.

![Amarra and the Finder Dock.](image)

For more information about the Dock, see the Help menu of your Mac.) Using the Control Key to access the Contextual Menu allows control of different commands in Amarra.
5.1.0 Amarra Application Menus ::

5.1.1 The File Menu:

About Amarra: Opens the modal About window. This is useful for verifying the version number of Amarra that you are running. Click anywhere in the window to close it.
Preferences: Opens the Preference window for Amarra. See Section 6 for more information.
Services: This menu proves access to any Services that are available to Amarra. Services extend an application or framework's functionality by sharing its capabilities with other programs.
Hide Amarra: Hides all Amarra windows. To reveal the windows, click on the Dock icon or tap the ,+tab key to cycle through running applications to select Amarra.
Hide Others: Hides all windows other than Amarra.
Show All: Reveals all windows.
Quit Amarra: Quits Amarra MINI.

5.1.2 The File Menu:

Open Tracks [Cmd+O]: Opens music files (tracks) from the Mac Finder.
Open Playlist: Opens previously saved Playlist files.
Save Playlist: Saves the current Amarra Playlist.
Convert FLAC File to AIFF...: Navigate to a FLAC file in the Finder and convert them to AIFF format.
Convert FLAC Folder to AIFF...: Navigate to a folder containing FLAC files and convert the folder's content to AIFF.
Authorization...: Opens the Amarra Authorization window. See section 4 of this document for more information.
Extras:

<table>
<thead>
<tr>
<th>Audio I/O Preferences...</th>
<th>Audio MIDI Setup...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panner – Amarra</td>
<td>Rescan I/O...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set Playback To Amarra</th>
<th>Set Playback To iTunes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Playback To Playlist</td>
<td></td>
</tr>
<tr>
<td>Toggle Mute</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cut</th>
<th>Copy</th>
<th>Paste</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Enable Debugging</th>
<th>System Console Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eject CD</td>
<td>Meters</td>
</tr>
<tr>
<td>Encode CD...</td>
<td>Send Crash Report...</td>
</tr>
</tbody>
</table>

Audio I/O Set up: Opens Amarra’s Audio Input/Output window.
Audio MIDI Set Up: Opens the Audio MIDI Set Up Window. This is useful for verifying connection to your DAC.
Panner: Opens the Amarra Panner window.
Rescan I/O: Forces Amarra MINI to query Core Audio for current interface status.

Set Playback To Amarra [Cmd+1]: Sets the source for playback as Amarra.
Set Playback To iTunes [Cmd+2]: Sets the source for playback as iTunes.
Set Playback To Playlist [Cmd+3]: Sets the source for playback as Amarra’s Playlist.
Toggle Mute: Toggles Amarra’s volume control between off and unity gain or full.

Cut: Cuts the currently selected string or item to the Clipboard.
Copy: Copies the currently selected string or item to the Clipboard.
Paste: Pastes the currently selected string or item from the Clipboard.

Enable Debugging: This is useful for providing Sonic Studio technicians important information regarding Amarra should any issues arise.
System Console Log: Opens Apple’s Console app. This is useful for providing Sonic Studio technicians important information regarding Amarra should any issues arise.
Eject CD: Ejects CD Media from its drive.
Meters: This line is disabled at this time.
Encode CD: This line is disabled at this time.
Send Crash Report: Send important information to Sonic Studio technicians.

NOTE: Toggling between Cmd+1 and Cmd+2 is a good way to compare the sound quality between Amarra and iTunes.
5.1.3 The Play Menu:

From Playhead: Amarra Plays from the last stop position
Repeat Play: Repeats a song
Stop: Stops all playback in Amarra.

5.1.4 The Playlist Menu:

Add Tracks From iTunes: [sft+cmd+i] Adds tracks selected in iTunes into an Amarra Playlist.
Add Consecutive Tracks [opt+cmd+i]: Adds consecutive tracks from iTunes. A specified number of tracks are loaded.
Add Tracks From Finder... [cmd+o]: Select and add audio tracks from the Mac Finder.
Clear Playlist: Clears the content of an Amarra Playlist.
Open Playlist: Opens a saved Playlist.
Save Playlist: Saves open playlist for later recall.
Playlist Window [opt+p]: Opens and closes the Amarra Playlist window.

5.1.5 The Desk Menu:

Open Sonic EQ Setup...: Navigate to and open a saved Sonic EQ state.
Save Sonic EQ Setup...: Saves current Sonic EQ state for later recall.
Save As Default: Saves the current Amarra state for recall at launch.
Toggle Mute: Mutes the audio output of Amarra. Restore the audio level on next evoke.
5.1.6 The Windows Menu:

- **Amarra** [opt+a]: Opens the main Amarra window.
- **iTunes** [opt+i]: Opens the main iTunes window.
- **Playlist** [opt+p]: Opens the Amarra Playlist window. Must enable Playlist mode.
- **Background Manager**: Opens the Amarra Background Manager window.
- **Equalizer**: Opens the Sonic EQ window.
- **NoNOISE**: When the NoNOISE option for Amarra is purchased, this line becomes active.

5.1.7 The Help Menu:

- **Amarra Help**: Opens the Amarra User Manual/Help document.
5.2.0 The Amarra Background Manager:

Amarra is equipped with the Background Manager whose function is to process sample rate conversion as a background process. The Background Manager window largely consists of 2 areas, the “Soundfiles” area and the “Processes” area, topped by the Target Folder field.

To open the Background Manager, select the Windows > Background Manager command.

The Background Manager utility allows:

1) The drag and drop of audio files into the Soundfiles section.
   When a sound file is selected in the list, the black status bar below the list displays the sample rate, word length and number of channels of the selected file. Multiple sound files can be added to the list by repeating this action.
   To remove sound files from the list, click to select the list entry and delete it by hitting the backspace or delete key. To clear the list of all sound files, click the Clear All button to the right of the Soundfiles list.

2) The definition of a target folder for the processed file.
   In the Target Folder field, the target folder for newly created sound files is specified. To select a target folder, click on the Set Folder button. A standard Mac OS browser opens, allowing you to navigate, create and/or choose the desired destination folder. Option–clicking on the Choose button forces Amarra to use the input file’s folder also as the target folder.

3) The definition of a target sample rate.
   The Sample Rate Conversion background process has thirteen choices of target sample rate. As with any SRC process, if the target sample rate matches the clock rate of the playback system, then the process is considered a sample rate conversion. If, however, the target sample rate does not match the clock rate of the playback system, then the process is considered a varispeed. In either case, the actual processed data in the file
is identical, only the sample rate flag is different. SRC preserves pitch and duration, while varispeed produces modified pitch and duration from the original.

The Target Sample Rate menu includes the following choices:

![Sample Rates](image)

4) A Queue section to monitor the processes progress.

Processes can be deleted from the processes list by clicking on the process and then hitting the backspace or delete key. To clear all processes from the Processes list, click the “Clear All” button to the right of the Processes list.

Once all necessary processes have been selected and placed in the right processing order, they can be automatically performed upon the selected sound files by clicking the “Execute” button. The sound files and the processes to be applied upon them are then “queued” and processing commences. To indicate this action, the “Queue” indicator to the right of the Execute button shows the number of sound files and processes queued.

Once the processes are being executed, all sound files and processes remain in their respective lists.

To abort the current process, click the Abort button and the current process will be aborted, initiating the next process in the Queue.
6.0.0 Using Amarra and iTunes

Amarra runs alongside Apple’s iTunes program. This allows you to manage and access all your music through the main iTunes Music Library or through custom iTunes Playlists.

As shown below, Amarra occupies the area to the left of your iTunes window:

You can use iTunes like you always have, select the songs / Playlists and play. Amarra will play all your songs and seamlessly switches to iTunes for playing back protected files such as songs purchased from the iTunes store.

Amarra plays most compressed files including FLAC, MP3, AAC, and Apple Lossless (ALAC).

NOTE: Amarra does not play compressed files on legacy G5-era Macs.

Using the Playlist button Amarra allows you to load the selected tracks from iTunes into Amarra as a Playlist. With the Playlist loaded iTunes is Not Used and is now stopped. This is indicated by the Playlist button turning Green and now showing the Tracks that are loaded as a menu.

See Section 6.6 for more information on using the Playlist.

NOTE: This feature will play the loaded tracks without any gaps.

NOTE: Amarra will load all tracks of the same sample rate and disable iTunes so the tracks can then be played in Amarra. This can provide optimal sound reproduction.
6.1.0 Using the Amarra Interface Module:

1. AMARRA / ITUNES
   This indicates Amarra’s playback status:
   Blue = Amarra is playing
   Grey = iTunes is playing
   Orange = iTunes is playing a protected file.

2. AMARRA EQ
   This opens (or closes) the Amarra EQ window. Option click to enable/disable EQ.

   With a Sonic Studio Interface you can also open the +DSP Sonic EQ.

3. CACHE PLAYBACK
   CACHE Loading for playback.
   When enabled songs are first pre-loaded into RAM to minimize disc access. This can be used in Amarra or Playlist Modes.

4. PLAYLIST
   This button brings up the Playlist Window.

5. TRACKS
   This displays the list of tracks loaded in the current Playlist.

6. CONTROLS
   These buttons control
   • Playlist Menu Commands
     - Add Tracks from iTunes
     - Add Tracks from Finder
     - Control Playlist
   • Playlist Play Options
     - stop at end
     - repeat playlist
     - load next tracks
   • Link for iTunes window
     - keeps iTunes window next to Amarra

   **TIP:** Holding the Mouse (without clicking) over any button will display a Help Tip displaying what the button does.

7. TRACK INFORMATION
   The upper display shows name and artist for the track.
   The middle displays the memory being used for CACHE playback. Current dither status is also displayed.
   The lower displays shows the Audio device and Sample Rate.

8. TIME AND TRANSPORT
   The Current Time, Previous Track, Play/Pause, and Next Track buttons are located here.

9. AMARRA VOLUME
   This slider controls the output volume.
   The buttons are hot spots for 0, -6, and -144 dB.
   The Up and Down Arrow keys on your keyboard can be used to control the volume.
   NOTE: iTunes and Amarra Volume are kept in sync.
   NOTE: You may notice a small delay and a small doubling of sound when using the iTunes Volume is being moved.

10. Meters and Output Level
    These show meters and volume control for.
    NOTE: Meters do not show activity when playing files from iTunes.
TIP: Want to hear that wonderful instrumental section again? Stop Amarra MINI, double-click in the seconds area of the Time Display section and use the down arrow to back up 1 second per key stroke. Hit the spacebar to start play at the new time selection.

When you launch Amarra, iTunes will automatically launch. Likewise, when iTunes quits Amarra will be shutdown. In the Amarra Preference Window, there is a check box which can be used to disable the auto launch / quit feature.

6.2.0 Amarra EQ

This section presents an overview of the Amarra EQ. Use this to alter the sonic characteristics of the sound. Amarra EQ employs a minimal phase topology and double precision operations to ensure inaudible results while preserving the fidelity of the most delicate acoustic performances.

The EQ window is opened by clicking on the EQ button at the top of the Amarra window. Use Option-Click on the EQ button to mute the EQ.

The EQ can also be set using the EQ presets as set in the Track Information from iTunes. Select a Track in iTunes and using “Get Info” select the “Options” Tab and set the EQ Preset.
Amarra EQ:
Use the Amarra EQ window to alter the sonic characteristics of the sound. Amarra EQ employs a minimal phase topology and double precision operations to ensure inaudible results while preserving the fidelity of the most delicate acoustic performances.

EQ (On/Off)
This turns on Amarra EQ, or when unlit indicates the EQ is not being used.

Amarra comes with a set of EQ settings that are modelled on the iTunes presets. In addition there are 3 Room Node settings for common bass adjustment processing.

NOTE: The Desk menu items allows you to save and recall your EQ settings. Set up an EQ, go to the Desk menu and select Save Sonic EQ Set Up.

NOTE: Amarra will also use the EQ Preset defined in iTunes to set the EQ for a Track.

Parametric EQ:
The parametric filter has parameters for Resonant Frequency, Gain and Quality Factor. The Quality Factor, or Q, is defined as the resonant frequency, or center frequency in the case of a symmetrical filter, divided by the bandwidth. The filter is a 1st Order filter.
Amarra provides three parametric filters to tailor your sound. All processing is done using 64-bit floating point arithmetic. The parametric filters are classic, three parameter versions, with Resonant Frequency, gain, and Q, Q or Quality Factor is defined as the resonant frequency, or center frequency in the case of a symmetrical filter, divided by the bandwidth. The bandwidth is, in turn, defined as the one or two frequencies at which the filter response is 3 dB up or down from unity gain.

The Amarra EQ Window also has a set of presets based on common Room Nodes for correcting simple room acoustics. Additional presets are based on an analysis of iTunes EQ Presets. Amarra uses the Sonic EQ to process the audio and provide the selected effect. The following presets are provided:

<table>
<thead>
<tr>
<th>Default User Setting</th>
<th>Jazz</th>
<th>Pop</th>
<th>R &amp; B</th>
<th>Rock</th>
<th>Flat</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bass Booster</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bass Reducer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Classical</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Expressing the width of a filter as a Quality Factor, rather than bandwidth, provides a more intuitive sense of the filter's subjective “sound,” since the same value of Q will produce different bandwidths at different frequencies. The higher the frequency, the wider the bandwidth will be for a given Q value, which roughly corresponds to our auditory mechanism's ability to perceive a filter's action.

As an example, a parametric filter with a Q of 1 has a bandwidth of 100 Hz when its center frequency is set to 100 Hz but, it has a bandwidth of 1000 Hz when the center frequency is set to 1000 Hz.

Curves for Parametric EQ:
The family of curves shown below include a wide Q of 0.5, a medium Q of 2.0 and a narrow Q of 10. The order or slope of this filter is 6 dB per octave.
6.3.0 Amarra Preferences

This section presents an overview of the Amarra Preferences.

**LAUNCH SETTINGS**

**LAUNCH / QUIT ITUNES::** Forces iTunes to launch or quit in sync with Amarra.

**HIDE ON LAUNCH ::** Forces Amarra to hide its windows after startup.

**LINK ITUNES WINDOW ::** Forces iTunes to remain ‘attached’ to Amarra’s main window, regardless of the main window’s location.

**LINK ITUNES EQ PRESETS ::** Forces Amarra to follow the EQ settings in iTunes.

**PLAYLIST FOLLOWS ITUNES ::** Forces Amarra’s Playlist to follow the track selections in iTunes.

**PLAYBACK SETTINGS:**

**BYPASS COMPRESSED FILES ::** Forces Amarra to skip over lossy encoded music files like MP3 and AAC.

  Useful for PPC Macs.

**TRACKS TO LOAD ::** Sets the number of consecutive tracks that Amarra pulls from iTunes when auto-populating a Playlist.

**MEMORY AMOUNT ::** Set the amount of Random Access Memory that Amarra uses to temporarily store audio in Cache Mode.

**DITHER SETTINGS**

**AUTO-DITHER ::** Automatically enables redithering when Amarra’s gain is not set to unity or 0.

**TYPE ::**

  **TPDF:** Sets Amarra’s redithering function to Sonic Studio’s proprietary Shaped TPDF (Triangular Probability Density Function) dither type.

  **MBIT+:** Sets Amarra’s redithering function to iZotope’s proprietary MBIT+ dither type.

  **Shape:** When Type is MBIT+, sets the amount of spectral shaping, from none to extreme.

  **Wordlength:** Sets the number of bits for Amarra’s output. This setting should match your DAC’s word length specification. If set to less than 24 bits, Auto-dither should be enabled for best quality.

**PROCESSING SETTINGS**

**FULL SONIC-EQ ::** Changes the Equalizer from iTunes-style generic curves to fully adjustable, minimal phase Sonic EQ. Not available in Amarra MINI or Junior.

**Pure Gain ::** Forces Amarra to change gain in 1 bit steps for less gain interpolation and higher quality.

**HardLimit::** Changes the way Amarra reproduces consecutive oversamples. Recommended for music with limited dynamic range.

**SONIC HARDWARE SETTINGS ::** Requires Sonic Studio Hardware.

**Launch/Quit Console:** Forces Sonic Console to launch or quit in sync with Amarra.

**Dim Front Panel:** Dims the front panel display.

**Control Volume:** Interlocks Amarra’s gain control with the hardware gain control so either can be used.

**Gain Adjustment:** Set the system gain to match professional (0 dB) or consumer electronic (-10 or -14 dB) standard levels.
If dither is enabled then the output of Amarra will be dithered to the setting of the Output Wordlength specified. This can be useful for providing the a better sound when Gain is used or if your DAC only supports a limited word length (16 or 20 bits).

**NOTE:** When the Output Wordlength is set to 24 bits the dither will be “disabled” if the Gain has not been modified (at full volume). Once the Gain is adjusted then dither is re-enabled.

Amarra provides two dither options: Sonic TPDF and Izotope's mBIT+ Dither. The mBIT+ is an advanced psychoacoustic dither and supports different shapes: Light, Medium, High, Ultra,

### 6.4.0 Using Amarra with Remote Control

#### 6.4.1 Remote Control Volume
You can use your iTouch / iPhone iTunes Remote to control the Volume in Amarra. When you adjust the volume using your Remote (or using iTunes) Amarra will follow.

**NOTE:** You may notice a small doubling of sound while using the remote volume control. This will stop once you stop moving the volume (iTunes will mute).

#### 6.4.2 Using Amarra with Infrared Remote Control

The Amarra Remote Application is used to support the Apple Infrared Remote. The Amarra Remote Application can be found in your Extras Folder and is only required for the infrared.

We can also recommended the “rowmote” iPhone/iTouch Application available via the iApp Store. For more information please visit [http://www.rowmote.com/Rowmote/Rowmote.html](http://www.rowmote.com/Rowmote/Rowmote.html)

#### 6.4.3 Using Amarra with Remote Control And Amarra Playlists

With Release 2.2 you can use the Apple Remote to control the Playlist. Use the “Link Remote” Preference to enable this feature. When Enabled you can choose tracks in iTunes (or Apple Remote) and the Playlist will automatically follow. Likewise, selecting a song in an Amarra Playlist will select the iTunes track.

**NOTE:** If you Add files from the Finder than this feature will Not Be Used.

**NOTE:** This may cause dropouts and skips with large iTunes libraries.
6.5.0 Using your Airport Express

Using the “Airfoil” application from Roque Amoeba allows you to route the output of Amarra to an Airport Express. For more information visit http://www.rogueamoeba.com/airfoil/mac/ for more information.
Amarra provides its own Playlist window that can be used to control playback of soundfiles instead of iTunes. The playlist is also used for playback of gapless material (reads the iTunes Gapless tag). Tracks can be loaded via a selection iTunes (from the Library, from an iTunes Playlist or from a CD) or using the Finder. You can also Drag and Drop files from the finder or from iTunes itself on the Playlist to add them.

**NOTE:** Use Playlist mode for playback of gapless recordings. Make sure the Gapless option is enabled for each song of a gapless recording.
iTunes song Get Info dialog box, Options tab.

Playlist Navigation :
  - Left Arrow = skip to next track and play it
  - Right Arrow = skip to previous track and play it
  - Down or Up Arrow = move to another track without stopping playback of current track. Hitting the Return key or spacebar 2 times stops the current track’s playback and starts playback of the newly selected song.

LINK BUTTON
  - This button will link the Playlist window to the Amarra Window.

PLAYBACK OPTIONS

Using the Playback Options button on the Amarra window you can choose to stop the playlist, repeat or load the next set of consecutive tracks in to the Playlist.
- Do Not Repeat Playlist and stop at end.

- Repeat Playlist from top.

- Load the next set of Tracks when this playlist is finished.

ADD ITUNES / LOAD ITUNES/ ADD FINDER
Files can be added from iTunes or from the Finder using these commands. The Add Finder command will prompt you to selected files to load. You can select multiple files and folders.

USING APPLE REMOTE VOLUME
You can use your remote to control the Volume using your Apple Remote or Rowmote Application.

USING LINK REMOTE PREFERENCE
With the "Link Remote" preference enabled Amarra will automatically load Tracks into the Playlist based on the selection in iTunes (which can be controlled using Apple Remote).

NOTE: If any files are added from the Finder then this preference is not enabled.

DRAGGING FILES AND FOLDERS
Files can be added from iTunes or from the Finder by dragging the Files or Folders from the Finder to the Playlist Window. You can also drag Tracks from iTunes.

NOTE: Inserting a CD into your Mac’s drive can yield stunning results when played back through a Playlist. Select the CD in the left margin of iTunes, then press the ADD ITUNES button in Amarra.
7.0.0 Registering Your Amarra Software

In order to receive warranty service, you must register your product with Sonic Studio. This may be done at any time with proof-of-purchase. We strongly recommend that you register with Sonic Studio as soon as you purchase your unit. This will ensure the best possible support for your purchase.

1. Your product will be registered with us.
   Registration is used as proof of ownership if your product is ever lost or stolen.

2. Sonic Studio updates Amarra software on a regular basis.
   This allows us to keep you informed of updates as they become available.

Please register your Amarra software using our automated registration Web page at:
   http://www.amarraaudio.com and click on Support => Register

Alternatively, our mail address is:
   Amarra Software Registration
   Sonic Studio, LLC
   330 Sir Frances Drake Blvd
   Suite A
   San Anselmo, CA USA
   94960-2552
   Fax 1-775-330-8923

If you encounter issues using Amarra please refer to the information below for assistance. If none of these steps address your problem please contact your dealer or Sonic Studio support for more help.
8.0.0 Troubleshooting Guide

Basic Macintosh Setup Tips

iTunes:
• Disable the Crossfade Songs preference in iTunes
• Disable the Sound Enhancer preference in iTunes
• Disable the Sound Check preference in iTunes

Energy Preferences
• Disable Sleep and other Energy saving Preferences.

Bluetooth
• Disable Bluetooth

Spotlight
• Disable Spotlight

Security
• Disable Infrared

TimeMachine
• Disable TimeMachine on your media drives.

• We highly recommend a fresh install of the operating on a clean disc. This can prevent problems later on.

• We also recommend that your computer be used exclusively for music playback. Email, web browsers, screen sharing and other applications can affect performance.

Issue: Amarra Authorization Answers.

I have entered my code and password correctly with a new password to do a re-activation, why is the application not being re-activated?

Verify that you have an Internet Connection. Your new password must be a new and never-used password. Verify that you have not previously used this password with this activation code.

How often will my application connect to the activation server via the Internet?

Your application uses the Internet when it is first installed, when it is re-activated (such as after a disk reformat and reinstall, or if the software is moved to a new computer). The application may also do a quick check with the server when you run the application.

software_DNA includes an anti-fraud system that disables activation codes in cases of credit-card chargeback or refund. Unless you are using offline activation (see below), your application will need to connect to the Internet at least once a month to verify the license status. When an activation code is revoked, the software remains in trial mode until a new, valid activation code is provided.

Will my application work if I don't have an Internet connection?

Yes, there is an offline activation method available. If no Internet connection is found during activation, or the activation server is not reachable, the software will ask you to do offline activation. The software will provide step-by-step instructions, where a file is written to disk that you move to a computer that does have Internet access (or email access). You can move this file via LAN, floppy disk, CD-R
or USB key. You can use your Internet browser (on a machine that does have Internet access) to visit a special page to upload this file and receive another file in return. If you do not have any working browsers then the file can be emailed to our tech support (note there may be a delay in the return of the file depending on the time of day and week).

**During activation what information is passed to the server?**

No personal information or information about your computer configuration are transferred. There is a one-way hash* of some machine configuration data, your chosen password, and the optional email address sent to the server. Your application may have an optional registration page and if you choose to fill that out, that information is also transferred during the first activation. If you do not provide the optional information (email address and registration information) then no personal information will be transferred. We suggest you do not use one of your important personal passwords for the activation password, or a password that personally identifies you.

*One-way Hash: Codes that identify parts of the computer are put through a special function (called a ‘one way hash’) that turns the codes into one code number that is unique to your computer but cannot be deciphered (or reverse engineered) to determine what those components are. Only this hash value is sent to the activation server and not the details on the computer parts.

**Can I move Amarra to another computer?**

Yes, this can be done easily. It is simply a matter of deactivating the application on one computer, reinstalling the application on the new machine, and reactivating the software. If you have remembered your password this will be a fast and easy process.

**What is the email address for and is it mandatory?**

The email address on the activation and reactivation dialogs is mandatory. It can be used to retrieve a lost password. When you provide the email address it will not be used for marketing purposes or sold / provided to any third party. If you do provide an email address we recommend it be one that will be active for some time.

**What if I have forgotten my password and did not provide an email address (or my email address is no longer valid)?**

During a reactivation the previously provided password is required. If the password has been lost and cannot be recovered (because an email address was not provided, or the email address is no longer valid) you will need to contact our support via email or by phone. We will be happy to reset your password.

**Will changes to my computer cause my application to stop working?**

There are no changes that will cause a permanent disabling of the software. Major changes (disk reformat being one such major change) will mean that you need to reactivate the software. If you have your password this will be a fast and easy process.
What happens if Sonic Studio or softWORKZ suspends service or goes out of business?

Both companies have been in business for several years, and are healthy and stable and will be around for many years to come!

Regardless, your activated application will continue working without the Activation server, although new activations or re-activations will not be possible. Both companies are committed to ensure that a patch will be made available ASAP to resolve this. Either a version with a replaced activation system or a version with no activation will be provided.

I wish to do an online activation but my firewall is set up to block such requests. What are the firewall settings?

The following is the information that you need to setup your firewall:
- Main server IP address: reg1.softworkz.com
- Backup server IP: reg2.softworkz.com
- Backup server IP: reg3.softworkz.com
- Port: 80 (Standard HTTP)
- Domain: softworkz.com

Why is an activation system required at this time?

Software companies around the world have come to realize that activation-type copy-protection systems provide a reasonable solution to the problem of piracy while at the same time respecting customers by not burdening them with a hard-to-use licensing system. Reducing piracy means that the software vendor can use steady revenues to further improve the product and guarantee business continuation. It is unfortunate that piracy exists because we know the majority of our customers follow the license terms but it is a fact of life in this digital age. We trust that this new system will be virtually transparent for the majority of customers.

Issue: Amarra operates in demo mode.

Solution:
- Amarra requires a Certified Audio Interface to operate in non-demo mode.

Issue: How to set up a remote volume

Amarra does not support streaming of remote songs.
Amarra requires that all volumes be mounted on the computer as a shared volume.

Solution:
- Mount the remote volume with Read/Write Access on your local Macintosh
  - Use the Network (Cmd-K) to locate and mount the remote volume
- In iTunes used the Add to Library command to add the songs from the Mounted Volume
- Mount the remote volume with Read/Write Access on your local Macintosh
Issue: Audio Clicking or Ticking Sound.

Solution:
• Disable Spotlight (add volumes to the Spotlight Privacy Preference)

1) Open System Preferences and locate the Spotlight Preference

2) Select the Privacy Tab and add all your media drives
Solution:
- Disable Network Shared Access.

1) Open System Preferences and locate the Sharing Preference
2) Disable Web Sharing, Remote Login and Remote Management.
   Please note for support the Remote Management preference may be required.

Solution:
- Disconnect multiple FireWire devices and reduce daisy-chained connections.

Solution:
- Shut down other applications such as email and browsers.

Solution:
- Increase the amount of RAM in your computer:

Solution:
- Check that all drives are HFS formatted.
  Amarra does not support FAT32 drives.

Solution:
- Change the Sample Rate manually using Audio Midi Setup to a different value.
  Then switch the Sample Rate back.
Issue: **Songs do not change or sound correctly.**

Solution:
- Disable the Crossfade Songs preference in iTunes
- Disable the Sound Enhancer preference in iTunes
- Disable the Sound Check preference in iTunes
- Disable Sleep and other Energy Preferences.

Issue: **Amarra does not play audio.**

Solution:
- Check Permissions - Are they Read / Write
- You may also Quit Amarra and iTunes and restart Amarra.

**NOTE:** Sound files with names that contain “:” or other foreign characters may not play properly. Changing the name of the soundfile can fix this.

Issue: **Amarra does not play audio.**

Amarra requires an input clock under Audio Midi Setup. If your device does not have an input when shown under AMS then please follow the instructions for creating an Aggregate Device.

Solution:
- Create an Aggregate Device under Audio Mini Setup.
  Please refer to the Aggregate Device Setup in the Documentation Folder.

Issue: **Sample Rate Does Not Change With Soundfile.**

Does your device support the sample rates for your music?
  - Amarra will only use the available rates on the device.
  - Otherwise, iTunes will be used (and sample rate conversion will occur).
9.0.0 Support

We are committed to your successful use of Amarra and offer support for Amarra through your local dealer or via phone and email through Sonic Studio. Please also ask your local dealer for assistance. They have a great deal of knowledge about Amarra and are an excellent resource.

For email support, send email to:

support@sonicstudio.com

You can always find the latest information and updates for Amarra at our website:

www.amarraaudio.com